Processing transparencies - a step-by-step guide

This manual gives a detailed description of how to process conference slides to
make them ready for publishing. The main goal of processing transparencies is to
convert the presented PowerPoint slides to the portable data format PDF.

It is assumed that an SPMS instance has been set up before you start processing
the transparencies. All screen shots and examples in this manual are taken from
previous conferences and workshops.

Slides are an additional element presented in the JACoW conference proceedings.
They have been published since 2005 on the JACoW web site.
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1 Step-by-step guide

Step 1: Login to the SPMS and check the box ‘Transparency Processing’:

IPAC 2012 User Profiles Michaela Marx I PA ] 2
Logout Search My Schedule Home ((%

Please select the privileges you want enabled

[¥] Conference Editor
| Editor QA

V] Transparency Processing

| Submit

Please contact the [PAC 2012 Database Adminsstrator with problems, and/or 07-TUN-12 14:05 (UTC +02:00)
SPMS Author: Marthew Arena — Fermi National Accelerator Laboratory JACoW SPMS Version 8.9.15
JACoW Legal and Privacv Statements

Step 2: Select “Transparency List” from the start screen:

IPAC 2012 Administrator Pages e IPAC]2
Logout Search My Schedule Home ((o'-_ {Tﬁ\

Gpen Al Clase &

] Editor/Procesdings Administratian
1 =" List PDF Crly Papers

) Abst archEz
L) Activity Log - Staff

| Seernfic Progeam Adminsstratan

A complete list of all talks will be displayed scheduled from Monday to Friday.

Hint: Print this list before you begin processing the slides to get an overview.

IPAC 2012 Contributions With Transparencies Hichacla o IPAC12
=
Paper ID [when | Contribution Title [speaker
MOXAPQL Monday 09:30 The Scientific Revolution Enabled by X-ray Free Electron Lasers Joachim Stohr - SLAC National Accelerator Laboratery Stanford Synchrotron Radiation Lightsource
Download Upload Email
MOXBPO1 Manday 10:00 | The First Twa Years of LHE Operation Stephaen Myers - European Orgarezation for Nuclear Research DG
Download Upload Email| | |
MOYAPDL Monday 11:00 Accelerator Driven Systems Dirk Vandeplassche - Belgian Nuclear Research Centre in Mol
e upload Email
MOYBPO1 [Monday 11:30 |State-of the At and Fubure Prospects m BF Supercondeuctiaty |Kenp Santo - High Energy Accelerator Research Grgamzation

Download Upload Email|

MOYCPOL Monday 12:00 [esign and Simulation of I0TA - 3 Novel Concept of Integrable Optics Sergei Nagaitsev - Fermi National Accelerator Laboratory
Download Woload Email Test Accelerator

MOOAAD]L Monday 14:00 Parformance of the Comell High-Brightness, High-Power Electron Injecter | Bruce Dunham - Comell Laboratory for Accelerater-Based Scences and Education, Cornell University
Download Upload Emai| | |
MOOAA02 Monday 14:20 wtation and Di ics for High ition Rate Linac-driven  |Stefano De Santis - Lawrence Berkeley National Laboratory
o Email FELS
MOOAADS Manday 14:40 Fast Feedback ies for L | Beam ilizati Sven Pfeiffer - Deutsches Elektronen-Synchratran
download Upload Emal
MOQRADL Monday 15:00 Thonum Energy Futures Robert Cywinski - Unversity of Huddersheld School of Applied Soences
MOOBAGE Maonday 15:20 Status and Future Perspectives of the HIE-ISOLDE Project at CERN Yacine Kadi - ] i for Nuclear ch ing L {EN)
Jownload Upload Emal
MOOBAGE Manday 15:40  |Development of a High-power Coherent THz Sources and THz- TDS Marsaafuami Kumnaiks - Waseda University Advanced Research Instiute for Seence and Engmeerng
Download Upload Email System on the basis of a Compact Electron Linac
MOOARD] Manday 14:00 A Praton-driven Plasma i with CERN 5P5 |Patric Muggli - Max-Plandk Institute fuer Fhysics
Jownload Upload Emal Bunches

» Start to process only talks which have already been presented or rather where the
talk has been uploaded by the speaker itself or by the local presentations manager.



Step 3: Select “Transparency Processing”:

IPAC 2012 Administrator Pages duzbrsdini [PAC]2
Logout Zearch My Schedule Home ((o'-_ 3‘&\

) Reassign "
) Geners

| Smernific Progeam Adminestratan

Click on Monday to start with the Monday talks:

IPAC 2012 Transparency Maintenance

Day Invited Oral Contributed Oral
Total | Assignable | Assigned | @ @ |Total|Assignable|Assigned | @ -]
é Monday ) 5 5 o(o| 5| 18 18 18 0o(0|18
Tuesday 12 12 12 1/1|10| 18 18 18 0|0|(18
Wednesday| 18 18 18 o(o|18( 12 12 12 0(0]|12
Thursday 15 15 15 0|j0|153| 0O 0 0 ojofo
Friday 9 9 9 o(o|9 0 0] 0] 0|00
Totals| 59 59 59 1/1|57| 48 48 48 0| 0|48

[ Get Next Transparency ] [ List My Active Transparencies l [ List All My Transparencies

Step 4: Download the slides file from the database:

— -

MOXAMHO1|Monday, 09:30 7 | |ugfload Download ansparency Assigned [Michaela Mark 23-Mav-10 21: 26 (UTE -04:000]

|
e File Uploaded [Michaela Mars 23-Mav-10 21:22 (UTE -04:00)] MOXAMHO 1 TALK PDF
File Uploaded [Takashi Kosuge z3-MaAY-10 04:13 (UTC -04:00)] MOXAMHOL1_TALK.PPT
Email: [23-mav-10 02:06 (UTC -04:00)] Please upload your presentation file.
Edit Complete @ [Maxim Kuzin 23-mav-10 00:06 (UTE -04:00)]
File Uploaded [Maxim Kuzin 23-mav-10 00:06 (UTC -04:001] MORXAMHO1.PDF
File Uploaded [Maxim Kuzin 23-mav-10 00:06 (UTC -04:00)] MOXAMHO1.PS
Paper Assigned [Maxim Kuzin 22-mavy-10 23:58 (UTC -04:00)]
File Uploaded [albrecht WWagner 2o-mav-10 03:32 (UTC -04:00)] MOXAMHO1 .doc
File Removed [albrecht Wagner zo-mav-10 03:33 (UTC -04:00)] MOXAMHO1.doc
File Uploaded [albrecht YWagner 19-mav-10 05135 (UTC -04:00)] MOXAMHOL doc
Email: [z2-APR-10 03131 (UTS -041009] [PAC'10: Chairman's Cocktail
Email: [z1-APR-10 04127 (UTS -041000] [PAC'10: Information for Speakers
Email: [23-FEB-10 0351 (UTC -05:00)] IPAC'10 Invited Oral Presentation
Abstract Initial QA Performed [Christing Petit-Jean-Genaz 17-FEB-10 09:19 (UTS -05:00]
Abstract Updated [Christing Petit-Jean-Genaz 17-FEB-10 09:19 (UTC -05:001]
Email: [04-0CT-09 11:51 (UTE -04:00)] IPAC'10 Invited Oral Presentation
Abstract Initial QA Performed [Christing Petit-Jean-Genaz o4-AUG-09 04:23 (UTC -04:00)]
Abstract Updated [Christine Petit-Jean-Genaz 04-AUG-09 04:29 (UTC -04:00)]
Abstract Owener Changed [Christine Petit-Jean-Genaz 04-AUG-09 04:28 (UTS -04:00)]
Email: [22-JuN-09 09:13 (UTC -04:00)] Inwited Oral Presentation at IPAC'10
Abstract Initial QA Performed [2kira Noda o4-JuN-09 20:05 (UTC -04:001]
Abstract Updated [2kira Noda 04-)uN-09 20:05 (UTC -04:00)]
Abstract Initial QA Performed [Christing Petit-Jean-Genaz 04-JUN-09 00:38 (UTC -04:00)]
Abstract Created [Christing Petit-Jean-Genaz 04-JUM-09 00138 (UTC -04:000]

<J
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The download screen shows all files which have already been uploaded to the
database by the author or by an editor. If a PDF version of the talk already exists
(labeled with a green arrow in the next figure) then this file should be downloaded.
Check the contents. In case everything looks fine just set the status to green, leave a
comment and the processing is finished.

Download files for MOXAMHO1

| Download a ZIP file with ALL the < last > files. |
:PPT - 'PPT' files
| Filename | Veson | |
MOXAMHO1_TALK.PPT | <last> - Sun May 23171426 2010 | [ log |

‘PS - PostScript files

~ T Flename | vewon | |
MOXAMHO1.PS < last> - Sun May 23 1307:22 2010 %[ Iog |

5 N N S A R N R A S A R A A R A N R R A S A R S L R R L A R R

‘PDF - Portable Document Format files

[ Flename | Veson | |

AssississssssapmEIEEIEEEL

e

MOXAMHO1.PDF [ < last> - Sun May 2313:07:35 2010 %] [ log |

AR R R R R R R R N R R N R e R R R R R R R R R R R R R R R R

:DOC - Microsoft Word documents

WAl EEEEIEIENIEEIEERIREREE

» In case you only find a PowerPoint version of the slides (ending is PPT or PPTX)
download that file and PowerPoint will start automatically.

Step 5: Run the PowerPoint slide show (press F5):

» Run the PowerPoint slide show and check every slide carefully for

- overlapping elements, e.g. due to animation
- strange or missing characters
- images or text appearing outside a slide

» In case everything looks fine just continue with step 6.
» In case you detect overlaps you need to
- separate the overlaps manually (works fine if only a few overlaps occur)
or

- separate the overlaps by running the split animations macro, see Appendix A
for details



Step 6: Convert the PowerPoint slides to Adobe PDF:

There are several ways to convert a PowerPoint file to PDF. The easiest way is to
print the slides to the Adobe PDF Printer:

LT [ Y B T O T MOOACO1_TALKPPTX [Read-Only] = Micrasaft PowerPoint T el = -
“ Home Insert Design  Transtions  Amimations  Slide Show  Review  View  Developer  Addins  Acrobat Q

B e Print -

B save & =

7 e 'fh Copies 1 =

51 Save as Adobe POF

Print
& Open —
o Close Printer B
European
Infa Adobe PDF
e, Rl XFEL

Recent T

New Settings
m . Print Al Slides &

Save & Send Slides :

Help [ funPage Sides 2

Print 1 slide per page
: LLRF System
8 e il 1230191
& o 34 J. Branlard, G. Ayvazyan, V. Ayvazyan, M. Grecki, M. Hoffmann, T. Jezyniski, T. Lamb,

Edit Header & Footer F.Ludwig, U. Mavri¢, S. Pfeiffer, C. Schmidt, H. Weddig, B. Yang,P. Barmuta, S. Bou Habib,
t. Butkowski, K. Czuba, M. Grzegrzotka, E. Janas, J. Piekarski, |. Rutkowski, D. Sikora,
t. Zembala, M. Zukocinski, W. Cichalewski, K. Gnidzifiska, W. Jatmuzna, D. Makowski,

A. Mielczarek, P. Perek, T. PoZniak, A. Piotrowski, K. Przygoda, A. Napieralski, M. Kudta,

S. Korolczuk, J. Szewinski, W. Wierba, K. Oliwa, H. Schlarb

IPAC 2012, New Orleans LA - May 215t 2012

(3% £ I (isD) ﬁ_é
\258) 7 Hceon ey (ISE v

P set the printer properties as shown in the next figure:

-
Layoutl Paper/Quality H Adobe PDF Settings |

—Adobe PDF Conversion Settings

Setup for JACoW - paper size, embed all fonts, compression, Acrobat 7 compatibility.

@

Default Settings: [N Ad Edit...

Adobe PDF Security: [None | Edit..
Adobe PDF Output Folder |Prompt for Adobe PDF filename ~|  Browse.
[ Adobe PDF Page Size: ISIide 75x10 L" Add |
[v View Adobe PDF results

[v Add document information

[~ Rely on system fonts only; do not use documentfonts E uncheck here

[v Delete logfiles for successful jobs

[v Askto replace existing PDF file <“ l check this box

) J

[ 0K ] [ Cancel




It could happen that slides do not scale correctly. This means parts occur outside the
margins etc. To fix this problem check the box named ‘Scale to Fit Paper’ as shown
in the next figure:

Pl 0 S HEE A9 o ST MOOACD1 _TALK PPTX [Read-Only] = Microsoft PowerPoint "I —
.i . Home Insert Design Transitions Animations Slide Show Review View Developer Add-Ins Acrobat

I save .

Print

& save as =

2 - Copies: 1 7

» Saveas Adobe PDF

Print
5 Open 1 I
O Close Printer
European
Info 7 Adobe PDF E

-, N XFEL

Recent Printer Properties
New Settings
m . Print Al Slides o
e e curoped
Save & Send Slides: :

Full Page Slides

Help L
— Print 1 slide per page ‘
(3 options Print Layout y\.

B8 Exit | | J E]
Full Page Slides Nates Pages Outline .
Handouts J. Branlard, G. Ayvazyan, V. Ayvazyan, M. Grecki
&l El F.Ludwig, U. Mavri¢, S. Pfeiffer, C. Schmidt, H. Wed«
1 Slide 2 Slides 3 Sides t. Butkowski, K. Czuba, M. Grzegrzotka, E. Janas,

| ] t. Zembala, M. Zukocinski, W. Cichalewski, K. Gni
4 Sics Horizontal 6 Sides Horizonal 9 Slces Horizontal A. Mielczarek, P. Perek, T. Pozniak, A. Piotrowski, |
E Bl S. Korolczuk, J. Szewinski, W. Wierk

4 slides Vertical 6 Slides Vertical 8 slides Vertical

Rt IPAC 2012, New Orleans L£

V| Scale to Fit Paper

H\Eh Quality
ﬁ HELMHOLTZ
‘ ASSOCIATION

.‘11|1

1 of40 »

There are alternative ways to convert PowerPoint slides to PDF. If the first method
fails try one of the following methods:

» Save as type PDF directly from PowerPoint, File > Save As

[P] save As
::);l | w Lacal Disk () b Users » mpymax b AppData » Local b Temp »
il
Organize = Mew lolder
B Desktop * Name ’

lp Downloads

[1EBT2352-5C98-4C5A-9ABA-F2FIBT2BC...

). [BFAFSDA4-9CIE-ACT4-0805-01C488C26.
= [FSEFE38A-DTCL-4FE4-AA43-68FI2DCIF .
(FAB5E497-4BBE-42D4-A260-0C3FB3203.. 1
Acrobat Distiller 10

=y Recent Plares

B Desktop

4 Libraries.
B Mamx, Michaela

L Adobe
& Computer
L. AKSinstall
& Local Disk (C)
x L. APNLogs -
+ Local Disk (D7)
[ . il !
i . df -
Save as type: |PDF (% pdf) -
w—
ALUTROIE: 00K 000 Tags Add atag

Options... | @ Standard (publishing
T Fh i P o online and printing)
] Open file after publishing i e

{publishing anling)

Click on Tools to set some
o ide Folders foots v | Save | | Conce necessary options!




[Tools hd | Save | [ Cancel

Map Network Drive...
Save Options...

General Options...

Compress Pictures...

» Tools > Save Options opens the following menu where you need to check the box
‘Embed fonts in the file’:

PowerPoint O

General .
L—_‘ Customize how documents are saved.
Proofing
s
Language save files in this format: ‘PowerPoint Presentation lzl

advanced Save AutoRecover information every minutes

Keep the last autosaved version if I close without saving

Customize Ribbon 5 s - -
AutoRecover file location: ‘\\wm‘desy‘de\home\mpymaX\APphcatlon Data\Microsoft\PowerPointy, |

Quick Access Toolbar . . .
Default file location: ‘\\wm‘desy‘de\home\mpyma)(\My Documents), |

Trust Center

Offline editing opti for d g server files

Save checked-out files to:[i)

() The server drafts location on this computer

‘-‘é" The Office Document Cache

Server drafts location: [\wwin.desy.de\home\mpymax\My Documents\SharePoint Drafts) | i Browse...

File merge opti for shared d g server files

Show detailed merge changes when a merge occurs

Preserve fidelity when sharing this presentation: ‘El_] MOOACO1_TALK.PPTX [Read-Only] El

( Embed fonts in the file (i
@ Embed only the characters used in the presentation (best for reducing file size)
) Embed all characters (best for editing by other people)

\

» Tools > Compress Pictures opens the following menu where you additionally need
to check the button to use the document resolution:

Compress Pi

Compression options:

Tools ~ | Save | [ Cancel ["] Apply only to this picture

Map Network Drive... Delete cropped areas of pictures

Save Options... Target output:

General Options... () Print (220 ppi): excellent quality on most printers and screens

() Screen (150 ppi): good for Web pages and projectors

Compress Pictures...
haring




If the above method fails please try one of the ideas given next. The first one
converts directly from PowerPoint to PDF using Acrobat PDFMaker.

PlocdRBE="-E9 03 S— — TUOAAO1_TALHPPT [Read-Only)jCompatibility Mode] = Microsoft PowerPoint
Insert Design Transitions Animations Slide Show Review View Developer Add-I Acrobat
. == == =

=y F b=

Create and Create and Embed
ttach to Email Send For Review Flash

Create |Preferences
PDF

Create Adobe PDF

eate and Email| Review And Comment _Flash

Create PDF x

Create Adobe PDF from current
document

) Acrobat PDFMaker Office COM
Addin
Press F1 for add-in help.
T

-
Preuddoc

ol
+ derifOslachon
G

Ver

P> Select the Acrobat tab and click the button “Create PDF”. Make sure that you've
selected the latest JACoW distiller job options by clicking the Preferences button
first. Set the conversion settings to JACoW-10.joboptions.

» If PEDMaker fails, then produce a postscript file and distill it to PDF.

Please note: Use a generic postscript driver to generate the ps file:
File = Print = select “generic ps driver” from the list of printers and check
the ‘print to file’ box.

You can also use the JACoW Postscript Printer Driver which is installed on each
computer in the proceedings office. If not, please visit the given link and follow the
instructions to install an A4 and an US letter format PS driver on your PC:

http://www-linux.qgsi.de/~rmueller/jacow/printer/#Download

» If a useful PDF file could be generated please check it and save the file to your
local working directory as “PAPERCODE_TALK.pdf”.

Step 7: Upload the PDF slides file to the database:

MOXAMHOT Manday, 09:30):7 V_( Upload [DaWwninad v Transparency Assigned [Michaela Marx 23-mav-10 21:26 (UTC -04:00)]
St StﬁmSE / v File Uploaded [Michaela Marx 2z-may-10 21:22 (UTS -04:000] MOXAMHO1_TALK.PDF
N——1 ~ File Uploaded [Takashi Kosuge 2z-MaAY-10 04:13 (UTC -04:000] MOXAMHOL_TALK.PRPT

v Email: [23-mav-10 02:06 (UTC -04:00)] Please upload your presentation file.

v Edit Complete @ [Maxim Kuzin 2z-Mav-10 00:06 (UTS -04:00)]

~ File Uploaded [Maxim Kuzin 23-MAY-10 00:06 (UTC -04100)] MOXAMHOL.PDF

~ File Uploaded [Maxim Kuzin 23-MAav-10 00:06 (UTC -04:00)] MOXAMHOL.PS

W Paper Assigned [Maxim Kuzin 22-may-10 23:58 (UTC -04:00)]

~ File Uploaded [albrecht Wagner 20-Mav-10 02133 (UTS -04100)] MOXAMHOL.doc

~ File Removed [2lbrecht Wagner zo-mav-1003:33 (UTS -04:00)] MOXAMHO1 . doc

v File Uploaded [Albrecht Wagner 19-mav-10 05:35 (UTc -04:00)] MOXAMHO1 .doc

v Email: [22-APR-10 02131 (UTC -04:000] IPAC'10: Chairman's Cocktail

~ Email: [21-APR-10 04:27 (UTC -04:000] IPAC'10: Information for Speakers

v Email: [23-FEB-10 09:51 (UTC -05:00)] IPAC'10 Invited Oral Presentation

v Abstract Initial QA Performed [Christine Petit-Jean-Genaz 17-FEB-10 09:19 (UTC -05:00)]
~ Abstract Updated [Christine Petit-Jean-Genaz 17-FEB-10 09119 (UTS -05:00)]

~ Email: [04-0cT-09 11:51 (UTC -04:0m] [PAC'10 Invited Oral Presentation

v Abstract Initial QA Performed [Christing Petit-Jean-Genaz 04-AUG-09 04:29 (UTC -04:00)]
'~ Abstract Updated [Christine Petit-Jean-Genaz 04-AUG-09 04129 (UTC -04100)]

~ Abstract Owner Changed [Christine Petit-Jean-Genaz 04-AUG-09 04:28 (UTC -04:00)]

v Email: [2z-)UN-09 09:13 (UTC -04:001] [nvited Oral Presentation at [PAC'10

v Abstract Initial QA Performed [Akira Noda 04-JUN-09 20:05 (UTC -04:00)]

v Abstract Updated [2kira Noda 04-JUn-09 20005 (UTG -04:00)]

~ Abstract Initial QA Performed [Christine Petit-Jean-Genaz 04-JUN-09 00: 38 (UTC -04:00)]
v Abstract Created [Christine Petit-lean-Genaz 04-1uUN-09 00:38 (UTC -04:00)]



http://www-linux.gsi.de/~rmueller/jacow/printer/#Download

» The file upload screen:

IPAC2010 File Upload Michaela Marx

Logout Search My Schedule Home

Abstract: MOXAMHO1 International Collaboration with High Energy Accelerators
Paper ID: MOxXAMHO1
Presentation Type: Invited Oral
Program 5Session: MOXAMH -- Special Opening Presentation
05/24/2010 0930 -- 1000
Main Hall
Capacity: 1200
File Type |Transparencies v| < Select file type “ Transparencies”
Platform | |nte| PC

File to Upload |00 cyments and Satil :
Comments {Optional)

Upload File

Back To Your Abstract List

File Name File Type Platform|Uploaded

MOxAMHDL.POF Portable Docurment Format Intel PC |23-MaY-10 00:06 (UTC -04:00)
MOxAMHOL PS Post Script File Intel PC |23-MAY-10 00:06 (UTC -04:00)
MOXAMHOL . doc Source File (MS Word, Open Office or LaTex)|Intel PC |20-MAY-10 03:33 (UTC -04:00)
MOXAMHD1_TALK PPT|Transparencies Intel PC |23-May-10 04:13 (UTC -04:00)

» Set the file type to “Transparencies” and click the “Upload File” button to
start the upload procedure.

Step 8: Set the slides status and leave a comment

Paper ID |Time Set Status Bqload Download|Log
MOYBMHDL |Monday/11:30 Upload (Download v+ Transparency Assigned [Michasla Mars 23-May-10 21:26 (UTS -04:00)]
7 ~ File Uploaded [Takashi Kosuge 23-mav-10 0420 (UTC -04:00)] MOYBMHD1_talk.mpg
Red “ File Uploaded [Takashi Kosuge 23-mav-10 04:28 (UTS -04:00)] MOYBMHOL1_TALK PPT
velloe ~ File Uploaded [Osamu Kamigaito 23-may-10 03:45 (UTC -04:00)] MOYBMHO1_talk.mpg
~ File Uploaded [Osamu Kamigaito 23-may-10 0344 (UTC -04:00)] MOYBMHO1_TALK.PPT
~ File Removed [Dsamu Kamigaito 23-mav-10 03:43 (UTC -04:00)] MOYBMHO1_TALK.PPT
\/
» Enter your comments:
IPAC2010 Transparency Maintenance Michaela Marx

Logout Search My Schedule Home

@ MOXAMHO1 — International Collaboration with High Energy Accelerators

Comments to Speaker Editor's Notes

FPPT slides have been successfully
converted to PDF. Please note: 3lide #2
has been excluded from the presentation
hy the speaker.|

Save

» and that’s it ©




2 How to take over a slides file

To process a file from a colleague you can take over it by assigning the file to

yourself.

» Go to the start screen for processing transparencies. Click on a day on the left to
get a list of all the talks presented on that day.

IPAC2010 Transparency Maintenance

Day

Invited Oral

Contributed Oral

Files|Assigned|Total | @ @ |Files|Assigned | Total | @ -

Mondayi Q Q 9 (0|09 & u] 6 (006
Tuesday 13 1 14 (0|0 |O0| 12 1 12 (0|01
Wednesday u} 14 (0|00 ] 15 |(0o|jof0
Thursday 1 11 (0|00 5 ] 12 |0|oOf0
Friday 1 a 7 (0|00 0O ] o (ofofo
Totals| 33 11 23 (00O 9| 28 7 45 |0|(0)| 7

y

[ Get Next Transparency ] [

List by Active Transparencies ] [ List All My Transparencies

» The “Assign To Me” button appears in the “Editor” column:

\

[ Sakae Araki
&ssian To Me

with the SNS
Superconducting Linac
‘van zhang - Oak Ridge
MNational Labaratory
Spallation Meutron Source

14:00-15:00 Hadron Accelerators

— Location: Main Hall

— Chair: Gwo-Huei Luo - National Synchrotron Radiation Research Center
Time |[Paper ID |Status|Files? Editor Title/Speaker Contribution Log
14:00|MOZMHO1 Experience and Lessons

Email: [za-mav-10 20:30 (UTC -04:00)] IPAC2010 Transparency Processing Status
Transparency Complete @ [Sakae Araki 24-mav-10 20:30 (UTE -04:00)] pdf slides file has
heen checked looks ok
Transparency Assigned [Sakas Araki z4-MAV-10 20:15 (UTC -04:00)]
Final QA Passed [Maxim Kuzin 24-MA¥-10 0317 (UTS -04:00)]
Dot Reassignment @ [Marlen Bugmann 23-Mav-10 19:53 (UTS -04:00)] author proof read
File Uploaded [Yan Zhang z1-MaY-10 10:13 (UTC -04:00)] MOZMHO1_TALK PDF
File Uploaded [Yan Zhang z0-Ma¥-10 15:45 (UTC -04:00)] MOZMHO1_TALK PPT
Edit Complete  [Stefano Deiuri zo-MAv-10 01:0% (UTC -04:001] [ove & table with pitstop]
“ 16 - General Formatting Problems
W 26 - Miscellaneous Minor Problams
“ TC04 Figure formatting incorrect (outside margins, single/multiple line caption not
centred/justified, Caption wrangly labeled [abbreviated, colon missing, wrong font
size, bold/italic/...])
v Edit Complete @ [Stefano Deiuri 20-mav-10 01:07 (UTC -04i0m] Please contack Christine
Petit-laan-Genaz [Is a ararfti]
v Edit Complete  [Stefano Deiuri 20-MAV-10 00:26 (UTC -04:00)]
v 16 - General Formatting Problems
W 26 - Miscellaneous Minor Problems
“ TC04 Figure formatting incarrect (outside margins, single/multiple line caption not
centredfjustified, Caption wronagly labeled [abhreviated, colan missing, wrang font
size, bold/italic/...])
~ TCO06 Reference formatting incorrect {indentation, hyperlink)
File Uploaded [Stefano Deiuri zo-May-10 00:24 (UTC -04:00)] MOZMHO1.PDF
File Uploaded [Stefano Deiuri 2o-May-10 00:24 (UTC -04:00)] MOZMHO1.doc
Paper Assigned [Stefano Deiuri 19-MaY-10 2327 (UTC -04:00)]
File Uploaded [Yan Zhang 17-MAY-10 15:46 (UTC -04:00)] MOZMHOL.doc
File Uploaded [Yan Zhang 17-MAY-10 15:45 (UTC -04:00)] MOZMHOL.PS
File Removed [Van Zhang 17-Mav-10 15:45 (UTC -04:00)] MOZMHO1 .doe
File Removed [Van zZhang 17-Mav-10 15:45 (UTC -04:00)] MOZMHO1.PS
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3 Processing slides: Unexpected error messages
3.1 Error message from PDFMaker

P PDFMaker doesn’t “distill”

File  Edit  View Insert Format Tools  Slide Show  ‘window Help  Adobe PDF

NG SR T ] B A o|@ Bieokniee 2 o] B oz w8 [E]=

=g

Qutline ¥ Slides =
~

Kyoto, 23t May 2010

International Particle Accelerator Conferend

THE MAGNETIC MODEL Ol
HADRON COLLIDER IN THE
O Acrobat PDFMaker =

» make sure the conversion settings have been set to JACoW-09 or higher

[EE Microsoft PowerPoint - [Presentation ]

@] File Edit Wew Insert Format  Tools  Slide Show  indow Help | Adobe PDF
|_1 = E‘I;a | & I-l|? ﬁi| f’, 2 fl g R ,Hﬂ |_=.: ‘@ Conwert to Adobe PDF

: @ @ ﬁ ! @ Convert to Adobe POF and EMail

= | Convert to Adobe PDF and Send for Review

Outlineg Slides
Change Conversion Settings

2 Acrobat PDFMaker.

Settings | security |
PDFMaker Settings
— Conversion Settings:

@ Setup For JACoW - paper size, embed all Fonts, compression, Acrobat 7 compatibility,

[¥] Views dobe POF result
[C]Prompt for Adobe POF file name
[C]conwert Dacument Informatian
Application Settings
[] Attach source Fils ba Adobe PDF
[] add bookmarks to Adobe POF
Add links o Adebe FDF
[[JEnable accessibility and reflow with Tagged POF
Save slide transitions in Adabe POF
Save animations in Adobe PDF
Convert Mulkimedia to PDF Multimsdia

[[] convert hidden slides to PDF pages
FDF layout based on PowetPaint prinker settings

® Copyright © 1967-2005 Adabe Systems Incorporated and its licensors. Al rights
"‘ reserved. Adobe, the Adobe logo, Acrobat, the Acrobat logo, PostScript, and
the PostSeript logo are sither registered trademarks or trademarks of Adobe
Adobe Systems Incorporated in the United States andfor ather countries.

=

P Make a postscript file (print to file) and distill the ps file to pdf
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3.2 Error message from Acrobat

» Missing Host Fonts

Adobe PDF X

Please go to the printer properties , "Adobe PDF Settings” page

@ When vaou create a PostScript file wou have ko send the hast Fants,
and turn OFF the option "Do not send Fonts to Distiller",

P Go to the printer properties, “Adobe PDF Settings” page and turn off
the option “Do not send fonts to Distiller”.
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4 Examples of problems

Example 1: Missing character in a formula

» Equal sign did not display correctly in the PowerPoint file

» It seems that the author did not embed all fonts

» To embed fonts in PowerPoint select File » Options » Save
and check the box “Embed fonts in the file”

§ o

oanred H Customize how documents are saved.
Proofing
Save presentations
Language save files in this format: IPowerPoiﬂt Presentation lz'
Advanced Save AutoRecover information every |10 i_—:i minutes

Keep the last autosaved version if I close without saving

Customize Ribbon
AutoRecover file location: !\\win.desy‘de\home\mpymax\ADplicat\'on Data\Microsoft\PowerPointy |

Quick Access Toolbar 3 . _
Default file location: I\\wm.desy‘de\home\mpymax\My Documents), |

Add-Ins
Offline editing opti for d t g t server files

P

Trust Center
save checked-out files to: (1

) The server drafts Jocation on this computer

@) The Office Document Cache

Server drafts location: i\\win.desy.de\home\mpyma)(\My Documents\SharePoint Drafts\, i i Browse...

File merge opti for shared d g server files

D Show detailed merge changes when a merge occurs

Preserve fidelity when sharing this presentation: |LE_|J TUOQAADL_TALK.PPT [Read-Only] [Compati... IZI

Embed fonts in the file i/

Embed fonts in the file

ed in the presentation (best for reducing file size)
r editing by other peaple;

Save fonts that are used in the A Regpic)
presentation in the file.

Other people who open the
document can view and use the
fonts, even if the fonts are not
installed on their computers.

Only TrueType and OpenType fonts
can be embedded.
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Example 2: Missing characters after the conversion to PDF

» The PDF file has been generated with PDFMaker. In this case mostly all numbers
disappeared:

Solution to the Coherent Line Problem

» The PDF file generated with the generic postscript driver looks perfect:

Solution to the Coherent Line Problem

Pickup

— 15.000 ns

» Usage of the generic postscript driver instead of PDFMaker solved the problem.

See http://www.ep.ph.bham.ac.uk/general/printing/winsetup.html for the postscript driver
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Example 3: Missing characters on a slide

» at a first go it's hard to detect the missing characters P look for blank boxes

4. Nuclotron-M & NICA project

Operation regime and parameters

r 5
I Injector: 2x10° ions/pulse of 197Au%2* I
1 at energy of 6.2 MeV/u 1 - ~

. b

Collider (45 Tm)
Storage of
30 bunches [ 1110° ions per ring
at 114.5 GeV/u,
electron and/or stochastic cooling

acc"eleration up to 100 Mel//u,
eleg¢tron cooling, accelergiion

/ Booster {25 'I\.ﬂ'l.]\\
1{2-3) single-turn injection,
Istorage of 20(4-6)x10°}

\ up to 600 MeV/u /

-~
47T NN 2 Z l,
4 Wy Stripping (80%) 1%7Au®2* [ 197Au7% ?
. ] N e
TWO. i /' Nuclotron (45 Tm)
IP-1®@ co!hder ®1r. I injection of one bunch'y
| rings | e of 1.1x10° ions, |
2x30 injection ||\ scceleration up to !
k cycles \\ 104.5 GeV/u max. ,’
b s s -
N :: - : ~ . -

—— -

P Solution: The author was contacted to submit a modified version ©

4. Nuclotron-M & NICA project

Operation regime and parameters

I Injector; 2x10° ions/pulse of 197Au®%"
| at energy of 6.2 MeV/u

Collider (45 Tm)
Storage of
30 bunches by 1x10° ions per ring
at1l-4.5 GeV/u,
electron and/or stochastic cooling

/ Booster (25 Tm) \\
1{2-3) single-turn injection,

I storage of 2-(4-6)x10°)
acceleration up to 100 Mel//u,
elegtron cooling, accelergtion

v up to 600 MeV/u /

-~

o

/

/27T SN 2
1/ Wy Stripping (80%) 197Aud2* => 1974y 79" T
- hd
{I ,’, Y
1 TWO. i r Nuclotron (45 Tm] ‘
IP-1@ co!hder ®1pr- ! injection of one bunch'y
| rngs | pv— of 1.1x10° ions, |
2x30 injection ||| joceleration up to !
!\ cycles \ 1-4.5GeV/umax ,/
\\ 5 \\ P “
N :: - = P - _”

-
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5 Remarks

This manual and the split animations macro is available on the JACoW website
(www.jacow.org). Look for

» For conference editors » Documentation

For the next version of this manual, comments, suggestions or daunting examples
from future conferences and workshops are most welcome.

Please send your refinements to michaela.marx@desy.de

Thank you to Raphael Muller from GSlI, in Darmstadt, Germany, who provided the
split animations macro for PowerPoint. The macro is platform independent and has
been tested successfully for Office 2003, 2007, Office 2010 and on a Mac.
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Appendix A
The Split Animations Add-In for PowerPoint

You need the file “SplitAnimations.ppa” on your local computer.
» Install the Split Animations Macro in PowerPoint from

File - Options - Add-Ins - Manage ... select PowerPoint Add-In and Go...
PowerPoint Options I B [ |

General [l . .

|:_é; View and manage Microsoft Office Add-ins
Praofing
Save Add-ins
Language Name Location Type
ndvanced Active Application Add-ins

Acrobat PDFMaker Office COM Addin C\...0.0\PDFMaker\Office\PDFMOfficeAddin.dil  COM Add-in

Customize Ribbon SplitAnimations C\...ng manual June 2010\SplitAnimations.ppa  PowerPoint Add-in
Quick Access Toolbar Inactive Application Add-ins

Custom XML Data C.Bl\Microsoft Office\Officel#\OFFRHD.DLL  Document Inspector
Invisible On-slide Content . B]\Microsaft Office\Officel \OFFRHD.DLL ~ Document Inspector
Off-Slide Content J\Microsoft Office\Officel \OFFRHD.DLL  Document Inspector
Trust Center OneNote Notes about PowerPoint Presentations icrosoft Office\Officel 4\ONPPTAddin.dIl  COM Add-in

Presentation Notes «.8)\Microsoft Office\Officel \OFFRHD.DLL  Document Inspector

Document Related Add-ins
No -ins

Disabled Application Add-ins
No ins

Add-n: Acrobat PDFMaker Office COM Addin
Publisher:  Adobe Systems, Incorporated

Compatibility: No compatibility information available

Location: C:\Pragram Files pG6]\Adobe\Acrabat 10,0\PDFMakerOffice\PDFMOfficeAddin.dil

Description:  Acrobat PDFMaker Office COM Addin

[ [Powe Foint Add-ins| ]|

Add-Ins &)

Ayailable Add-Ins:
I~ SplitAnimations H Load

Unload

(adeien. | Click Add New and browse for a file named

SplitAnimations.ppa
g PP

A new tab named ‘Add-Ins’ will appear on the PowerPoint menu:

Design Transitions Animations Slide Show Review oW Add-Ins Acrobat

&y Split Animations

Custom Toolbars

Slides Outline X

1
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Example: Slide containing overlaps

» click the ‘Add-Ins’ tab and execute the Split Animations Macro

PlbedB @2-29-0| Example TUO2C06_TALKPPTX - Microsoft PowerPoint — @

o

P

Home Insert Design Transitions Animations Slide Show Review View Developer Add-Ins

By split Animations ?

stom Toolbars

V Tools : Split Animations X

= ',

% RCS history of beam power and |

Branch duct of HO dump line and downstream BPM (H:
— Due to foil scattering
— Solve by the minimized foil and additional collimator installation.

1 | mes nistory of beam power and

i-san and Saha-san’s talk)

Dispersion maximum point (Hotchi-san’s talk)
— Due to insufficient chromatic correction.
— Solve by the AC sextupole power supply
10000 _ IROKW MLF
—o— Branch duct for H dump ser operation

—o— BPM2-1(Downstream of H’ branch)

—&— Dispersion maximum point | 20kW MLF
in the arc section H

—— Duct during the injection seﬁlums

~— First secondary collimator | . A8

Dagiicl N ' ! l\\" L:
Worse collimator setting cause high activation
of secondary colllmator and arc

\,& R4l

1E20

. 4 1E19
1000 L user operation

1EI8

1E17

lesidual dose rate [uSv/h]

10
Regarding ths loss during the injection septum 1 and 2
— We also investigate the loss dependence on the peak current.

LI ] Tl

1E16

The number of accelerated particles per day [#]

1E15

2007/10/01 2008/10/01 2009/10/01 1
| Date i
» Example slide split into 5 separate slides:

BlozaR&9-09-0]- Example TUD2C06_TALKPPTX - Microsoft PowerPoint = @J &2
m Home Insert  Design  Transitions  Animations  Slide Show  Review  View  Developer | Add-Ins @

@ splt Animations

par

Sides | Outline x a

. RCS history of beam power and
residual dose

| 1 [ resnistoryorbosmporarane || &
it

2 | RES his tory of beamposar and.
|
m)
10000 - 120kWMLF _, 129 5
—o— Branch duct for H' dump ! us‘grup-.rmiml >
| per——— - BPM2-1(Downstream of H’ branch) S
o e ] —#— Dispersion maximum point 20kW MLF i+ 4_ o5 ;'Q_
T = 1000 b e asaection ] user npur:ltmn 8
5 = Duct during the injection seftums — e f -
! First secondary collimator ‘e
£ ‘—-é___ t
‘ Iy Particle number / E18 &
o E— = / gl o
—————— 2 X 2
4 |7 Res bistory ot beampowar amd 2 100 i | f \, l ]
N G0 —1] o Al byl / b}
e ] s AHIAAN I/ 7 B
- = il \ 4 1E17 8
= T E /| il \ g
g b AT | 4 =
T : M e 2
! ! =
L e \ / \ N | ' 4166 2
—— ' | 5]
L T T ——— | E] -
P EEES— Y 1 ° %
=== ] 4
. | ! i i L : A NI L A 1E1S = 2
i | "O(W/l()’()l 2008/10/01 2009/10/01 1 ¥
b 14 Date P
— Click to add notes =
- v
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